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Abstract  5 
The development of physics-based 3D models that investigate the behavior of biological tissues requires effective 6 
and efficient visualization tools. The open-source software ParaView has such capabilities, but often impose a 7 
steep learning curve due to the use of the Visualization Toolkit (VTK) data structures. To overcome this, I show how 8 
to setup the components of 3D vertex-like models, i.e., vertices, faces, and polyhedra, into the VTK data format 9 
and then output as ParaView unstructured grid files. I present a few relevant tools to visualize and analyze the files 10 
in ParaView. All sample codes are available in the Github repository vis3Dvertex. 11 
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1. Introduction 14 
The development of 2D continuum- [1], particle- [2], and vertex-based models [3-5] to understand the behavior of 15 
cellular tissues has revolutionized our understanding of how biological cells behave and interact with each other 16 
from a mechanistic point of view. One remarkable example is how vertex models allowed us to understand how 17 
epithelial tissue in the lungs behave differently for normal vs. asthmatic tissue [6]. In this work, the visualization of 18 
modeling and experimental results was crucial to understand the biological processes. 19 

With the rapid advancement of biological imaging and computational power, it is reasonable to expect the further 20 
advancement of 3D vertex models as the 2D models rely on the assumption that a cross sectional plane of a 3D 21 
tissue is representative of the entire height of a monolayer tissue. Although this is a reasonable assumption in 22 
many instances, for various other cases, it is not [7, 8]. Beyond the monolayer configuration, researchers have 23 
developed 3D vertex models to understand how polyhedral-shaped cells behave in a three-dimensional tissue. 24 
Studies as early as 2004 [9] developed 3D vertex models to understand cell deformation and rearrangement under 25 
external forces. Merkel and Manning [10] showed that a vertex-like 3D self-propelled Voronoi (SPV) model, 26 
governed by an energy functional depended on cell shapes exhibited a rigidity transition, similarly to the 2D vertex 27 
model. In general, vertex-like models in 2D and 3D include vertex [11] and Voronoi [10] models. The former has 28 
the cell vertices as the degrees of freedom whereas, in the latter, a Voronoi tessellation is created based on the 29 
cell centers which, in turn, are considered the degrees of freedom. Hereinafter, the term “3D vertex models” refers 30 
to the class of vertex-like models, including vertex and Voronoi models. 31 

An essential component to the further advancement of 3D vertex models is the efficient visualization of simulation 32 
results. However, 3D visualization is not trivial because visualizing polyhedra requires rendering, that is, converting 33 
a 3D image into a 2D image in the computer. Rendering can be a computationally intensive task, which may limit 34 
the user’s possibilities while visualizing simulation results because every time the user changes the at angle, 35 
transparency, or coloring, a new rendering is performed. Thus, fast 3D rendering is indispensable for the 36 
visualization of 3D vertex models. 37 

2. Problems and Background 38 
In the published work of 3D vertex models, mostly two software have been used for visualization: POV-Ray [12] 39 
and MATLAB [13]. POV-Ray is a free and open-source ray tracing software that generates renderings based on a 40 
text-based scene description. It shows an intuitive representation of the data and has very high-resolution 41 
rendering, to the point that some renderings (not from vertex simulations) resemble real pictures. POV-Ray’s main 42 
disadvantage is the lack of user interaction. If the user wants to change the camera angle or the rendering color, 43 
those must be done in the text-based scene description file, and then re-render the visualization. MATLAB is a 44 
proprietary software with limited 3D rendering capabilities that includes camera angle changes, zooming in/out, 45 
but it lacks the ability to manipulate on the rendering. 46 
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Some scientific visualization software have been especially designed for fast 3D rendering of scientific data, such as 47 
VisIt [14], ParaView [15], and Avizo (Thermo Fisher Scientific). All have a GUI with a pipeline of input data and data 48 
manipulators rather than text-based interfaces like MATLAB or Matplotlib [16] that are commonly used for 49 
visualization of 2D simulations. Avizo is a commercial software widely used in the petroleum and geophysical 50 
communities. VisIt and ParaView are free and open-source and have extremely powerful parallelization 51 
capabilities. To put into perspective, the Department of Energy (DOE) Advanced Simulation and Computing 52 
Initiative (ASCI) developed VisIt for terascale simulations. ParaView was also designed to visualize and analyze 53 
extremely large datasets. It has successfully run on various platforms on 4000-32000 cores and it was able to 54 
visualize a billion-particle simulation [17]. Although parallelization of scientific visualization is not the focus of this 55 
work, ParaView allows this extension if parallelization of 3D vertex simulations becomes necessary. 56 

In this work, I use ParaView to demonstrate how to visualize and analyze 3D vertex model simulations used in 57 
physics-based models. ParaView provides interactive visualization such that the user can view the 3D rendering 58 
from various angles, change color palettes, transparency, and rendering representation (e.g. wireframe, surface, 59 
volume) with a few mouse clicks. It contains filters that operate on the input data which can be manipulated, and 60 
then represented by plots, spreadsheets, or renderings. ParaView has an animation tool for time-lapse simulations 61 
to create movies or jump from a time step to another. Finally, it allows Python batch scripting without the need of 62 
using the pipeline. 63 

ParaView handles its data structure using the Visualization Toolkit (VTK) [18], which may pose a steep learning 64 
curve for computational biologists, physicists, and engineers. To overcome such a hurdle, I briefly explain the VTK 65 
data structures necessary for a polyhedral mesh. I present a pseudocode to “convert” faces and vertices of 66 
polyhedral data into VTK data structures and output ParaView independent or a timeseries of files. I use the 67 
voro++ library [19] to create polyhedra by Voronoi tessellations. I modify voro++’s examples to create and output 68 
VTK data structures. All sample codes are available in vis3Dvertex along with a Singularity container image file 69 
(available on Github release page) that can be used to run the sample codes on a Linux machine with Singularity 70 
installed. In Section 4, I show how to visualize the output files in ParaView as well as how to manipulate the data 71 
using a few filters relevant for 3D vertex models. Although the focus of this work is on applications for biophysical 72 
models, this work is also relevant for any application that uses polyhedral unstructured meshes such as the 73 
materials science community who have used Voronoi-based models to understand material behavior under stress 74 
[20-23]. 75 

3. Paraview and VTK framework: Creating 3D polyhedral unstructured grids 76 

3.1.  VTK data structures and VTK polyhedral grids 77 

I will briefly give some examples of VTK data structures and refer the reader to the free-to-download VTK user’s 78 
guide, textbook, and Doxygen manuals for more details: https://vtk.org/documentation/. The primary data 79 
structure in VTK is a data object. Data objects can be abstract such as graphs and trees or well-defined such as 80 
structured or unstructured grids – the latter being the focus of this work. In structured data, for example 81 
rectilinear grids, we know the connection between nodes (i.e. topology) and, therefore, we do not need to 82 
explicitly define the coordinates of each point. Unstructured data, on the other hand, require topology and point 83 
coordinates to be defined. Consequently, unstructured data demands considerably more memory, and one should 84 
only use it when structured grids are not possible. 85 

A VTK structured or unstructured grid is composed of “cell types.” VTK supports various cell type dimensionalities 86 
such as vertex in 0D, line in 1D, triangle, quadrilateral, polygon in 2D, and tetrahedron, hexahedron, polyhedron in 87 
3D (defined in the VTK source code vtkCellType.h). Cell types with a regular geometry, like tetrahedra (4 faces) 88 
and hexahedra (6 faces), use the vertices’ coordinates and a predefined ordering of the cell’s vertices to describe 89 
the cell topology. Thus, although we need to state the point coordinates, we do not need to explicitly define the 90 
topology of tetrahedral and hexahedral grids, saving some memory. In contrast, irregular polyhedral cells have a 91 
varying number of faces, and they need to have their topology explicitly defined along with their point 92 
coordinates. This work focuses on the polyhedral cells, represented by the VTK_POLYHEDRON cell type, to allow 93 
the visualization and analysis of the most general 3D unstructured grid that is used in physics-based 3D vertex 94 
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models. Furthermore, the methodology presented here can be applied to experimental data whose vertex 95 
positions and topology are defined. Note that the VTK_POLYHEDRON only handles convex polyhedra; if concave 96 
polyhedra exist, then the VTK_POLYGON cell type can be used instead, such that a set of polygons would compose 97 
a polyhedron. 98 

The topology or connectivity in polyhedron cells is stored as stream of ordered faces in the following format: 99 
[numberOfCellFaces, (numberOfPointsOfFace0, pointId0, pointId1, … ), 
(numberOfPointsOfFace1, pointId0, pointId1, …), … ]  100 

where numberOfCellFaces is the number of faces in the cell, numberOfPointsOfFace0 is the number of 101 
points in the 0-th face, pointId0 is the vertex index of point 0, pointId1 is the vertex index of point 1 and so on. 102 
Figure 1 shows one polyhedron and its face and vertex indexing lists from voro++’s modified example 103 
cell_statistics_vtk.cc. 104 

 105 

Figure 1: A polyhedron with labeled indices: vertex (blue) and face (red); and its VTK_POLYHEDRON face stream (top) created 106 
from voro++’s modified example cell_statistics_vtk.cc. The black number is the number of faces in the polyhedron, 107 
pink numbers are vertices per face, blue numbers are vertex indices, and red numbers are face indices.  108 

To add a cell into the unstructured grid vtkUnstructuredGrid, I use the method InsertNextCell: 109 

vtkIdType InsertNextCell(int cellType, vtkIdList *faceStream)  110 
where cellType is VTK_POLYHEDRON and faceStream is shown in Figure 1.  111 

The point coordinates are explicitly defined in the vtkPoints object and added to the vtkUnstructuredGrid 112 
with the method InsertNextPoint: 113 

vtkIdType InsertNextPoint(double xCoordinate, double yCoordinate, double zCoordinate)  114 

With cells and vertices defined, the basic components of an unstructured grid, I can now define attributes for the 115 
grid. Attributes can be variables used in the simulations such as time, pressure, velocity, force, surface area, 116 
volume, etc. These attributes are stored as data arrays whose number of components is defined by the user (see 117 
examples in Figure 2). Attributes can be point-, cell-, or field-based: PointData attributes are associated with the 118 
points whereas CellData attributes are associated with each polyhedron and assumed constant over the entire 119 
cell. FieldData gives a characteristic of the entire mesh – a common example is the time stamp. 120 

3.2. Pseudocode 121 

Figure 2 provides a pseudo code of the concepts of Section 3.1. The first three blocks create the VTK objects for the 122 
unstructured grid and points objects. After these objects are created, three nested for-loops are necessary – cell, 123 
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face, and vertex – to populate the vtkPoints object and to create the ID list of the VTK_POLYHEDRON cell type. 124 
In the vertex loop, I insert the points coordinate into vtkPoints and add the vertex index into the vtkIdList of 125 
VTK_POLYHEDRON (Figure 1, blue numbers). In the face loop, the number of vertices per face (Figure 1, pink 126 
numbers) are inserted into the vtkIdList of VTK_POLYHEDRON. After the face loop, I insert each cell attribute to 127 
its corresponding object. 128 

After the nested for-loops, cell attributes objects (e.g. cellID, cellVolume) and are inserted into the 129 
unstructured grid as a CellData attribute. The points and their PointData attributes, if any, are also inserted 130 
into the unstructured grid. Finally, I output the unstructured grid using a vtkWriter object. 131 
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// create unstructured grid and points (i.e. vertices) 1 
create vtkUnstructuredGrid object 2 
create vtkPoints object 3 
 4 
// create field attributes (e.g. vtkTime) 5 
create vtkAttribute object 6 
set vtkAttribute number of components (scalar==1; vector==3) 7 
set vtkAttribute number of tuples = 1 8 
set vtkAttribute name 9 
 10 
// create cell attributes (e.g. cellID, cellVolume, cellPosition) 11 
create vtkAttribute object 12 
set vtkAttribute number of components (scalar==1; vector==3) 13 
set vtkAttribute number of tuples = number of cells 14 
set vtkAttribute name 15 
 16 
cellCounter = 0 17 
loop through cells 18 
    create vtkIdList object to represent cell 19 
     20 
    // start creating the face stream as defined in Code XXX 21 
    insert number of faces to vtkIdList 22 
    loop through faces 23 
        insert number of vertices to vtkIdList 24 
        loop through vertices (using right-hand rule with inwards surface normal) 25 
            insert vertex to vtkPoints 26 
            insert vertexID to vtkIdList 27 
    insert cell (i.e. vtkIdList) as a VTK_POLYHEDRON to vtkUnstructuredGrid 28 
 29 
    // add attributes to cell 30 
    insert cellCounter to cellID 31 
    insert volume of cell to cellVolume 32 
    insert (x,y,z) position of cell to cellPosition 33 
     34 
    update cellCounter 35 
 36 
// add cell data to unstructured grid 37 
insert cellID to vtkUnstructuredGrid 38 
insert cellVolume to vtkUnstructuredGrid 39 
insert cellPosition to vtkUnstructuredGrid 40 
 41 
// add point data to unstructured grid 42 
insert vtkPoints to vtkUnstructuredGrid 43 
 44 
// populate vtkTime and add field data to unstructured grid 45 
insert simulation time to vtkTime 46 
insert vtkTime to vtkUnstructuredGrid 47 
 48 
// output unstructured grid 49 
create vtkWriter object 50 
set vtkWriter data to output (i.e. vtkUnstructuredGrid) 51 
set vtkWriter file name 52 
set vtkWriter file type (e.g. binary, ASCII) 53 
update vtkWriter (i.e. outputs file) 54 
 55 
// add unstructured grid filename to time series file 56 
update time series file 57  132 

Figure 2: Pseudocode to create a polyhedral vtkUnstructuredGrid with VTK_POLYHEDRON cell type. 133 

When the simulation iterates over time (or is minimized), one can write a ParaView timeseries file (.pvd) with the 134 
time stamp of each iteration and its corresponding “.vtu” unstructured grid file. For this iterative case, the 135 
pseudocode of Figure 2 would be contained within an iterative loop and each “.vtu” file needs the time stamp as a 136 
FieldData (second code block of Figure 2). Supplementary Figure S1 illustrates a timeseries for 5 iterations 137 
implemented in the voro++’s modified example random_points_vtk.cc. 138 

 139 
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3.3. Sample code using voro++ 140 

Figure 3 shows a snippet of random_points_vtk.cc with point coordinates insertion followed by the face loop 141 
where the vtkFaces object is populated for a single polyhedron. Note that in the voro++ library, the container 142 
that holds the Voronoi cells does not have a global list of vertices. The vertices are, instead, listed per cell. When 143 
two cells share a face with 𝑁 vertices, these 𝑁 vertices are listed twice in the global list. Thus, in the example 144 
random_points_vtk.cc, the global list of vertices, points, has repeated point coordinates. Other codes, 145 
however, may have a unique list of global vertices in which case the variable containerVertexStartIndex 146 
would not be necessary. 147 

// loop vertices and store their position 
for( unsigned int i=0 ; i<v.size() ; i+=3 ) { 
    points->InsertNextPoint(v[i], v[i+1], v[i+2]); 
} 
 
// loop over all faces of the Voronoi cell and populate vtkFaces with 
// numberOfVerticesPerFace and their vertex indices 
int j,k=0; 
int numberOfVerticesPerFace; 
while( (unsigned int)k<f_vert.size() ) { 
    numberOfVerticesPerFace = f_vert[k++]; 
    vtkFaces->InsertNextId(numberOfVerticesPerFace);  // number of vertices in 1 face 
 
    j = k+numberOfVerticesPerFace; 
    while( k<j ) { 
        int containerIndex = f_vert[k++] + containerVertexStartIndex; 
        vtkFaces->InsertNextId(containerIndex); 
    } // end single face loop 
} // end vertices loop  148 

Figure 3: Snippet of point coordinate insertion and VTK_POLYHEDRON implemented in random_points_vtk.cc. 149 

4. Implementation: ParaView basics 150 
ParaView[15] works with visualization pipelines of sources, filters, and outputs. Figure 4 shows the main GUI 151 
components. In the “Pipeline Browser,” the user can view sources and filters along with their pipeline hierarchy 152 
indicated by the indentation. The user can select the “eye” on the left of the object to make it visible in the “3D 153 
View.” The “Properties” and “Information” panels are below the Pipeline Browser. These will display the properties 154 
and information of the pipeline selected object. The Properties panel also has the “Advanced Toggle” button 155 
which, if selected, displays additional properties about the object. Above the Pipeline Browser and 3D View, in the 156 
“Menu Bar,” the user can access most of ParaView’s features and “Toolbars,” which provides shortcuts to 157 
commonly used features. For an extended basic tutorial, refer to ParaView’s tutorial: The ParaView Tutorial 158 
version 5.4.1 [24], section – although an older version, the basics are mostly compatible with recent versions 5.9.X. 159 
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 160 

Figure 4: Paraview GUI. Figure adapted from Moreland [24] using voro++’s modified example random_points_vtk.cc. (A) 161 
The entire sample colored by cell volume. (B) After "Threshold" filter is applied with the criterion 0 ≤ cellVolume ≤ 0.5 (blue 162 
box). (C) A cross sectional plane at the plane indicated in panel A – for details, see SI Section 3. 163 

5. Illustrative examples: relevant filters and tools for 3D vertex models 164 
All filters in ParaView are accessible through the Menu Bar (Filters -> Alphabetical) or through shortcuts in the 165 
Toolbar. The “Threshold” filter allows the user to define a scalar’s minimum and maximum threshold values. The 166 
cells within these limits will be displayed in the viewer. Figure 4 shows the entire Voronoi container before (panel 167 
A) and after the Threshold filter is applied (panel B and blue box). 168 

The “Glyph” filter is useful to visualize vectorial data that can be displayed as a line to represent orientation or as 169 
an arrow that also includes the direction. In physics-based model, this representation is helpful to visualize velocity 170 
fields and cell orientation (polarity). Sahu, Schwarz [25] used the glyph filter to visualize cell stratification in the 171 
presence of heterotypic surface tension as shown in the blue-green-purple cells of Figure 5. The stratification 172 
becomes more evident with the cell orientation illustrated by the line glyphs positioned at the cell center. For 173 
more details on cell orientation, see Supplementary Information (SI) Section 2. 174 

For simulations where cell velocity data is available, the filter “Stream Tracer” produces streamlines using a Runge-175 
Kutta integrator on the velocity data. Here, to illustrate a meaningful example of 3D streamlines, I use a simulation 176 
from Sanematsu, Erdemci-Tandogan [26] to illustrate 3D streamlines around a spherical object as well the cells’ 177 
velocity field as arrow Glyphs. 178 

 179 

Figure 5: Glyph filter to show (A) cell orientation (reproduced from Sahu, Schwarz [25]; licensed under a Creative Commons 180 
Attribution (CC BY) license); (B) velocity field; and (C) Streamlines generated by Stream Tracer filter. 181 
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The “Calculator” filter manipulates point or cell data by performing arithmetic operations. For cell-shape based 182 

models [10], Figure 6A shows how to calculate the cell shape parameter 𝑠 = 𝑆/𝑉2/3, where 𝑆 is the observed cell 183 
surface area and 𝑉 is the cell observed volume. This example shows how a filter can be used to derive data and 184 
reduce storage space. 185 

In addition to filters, “Interactive tools” are very useful during development and development (Figure 6B, C). They 186 
display cell or point data as the user hover the mouse over cells. For implementation details refer to SI Section 4. 187 
Another practical feature is the “File -> Save State”, which saves the pipeline workflow in a “.pvsm” file. This state 188 
file can be later loaded (File -> Load State) and the pipeline workflow is applied to the original data or another 189 
dataset (see SI Section 5). 190 

 191 

Figure 6: voro++’s modified example import_vtk.cc. (A) Calculation of cell shape parameter (𝑠 = 𝑆/𝑉2/3) using the 192 
“Calculator” filter (red rectangle) to manipulate CellData. (B) Display of “Hover Cells On” of the purple outlined cell. (C) Pink 193 
outlined cells selected using “Interactive Select Cells On”: green numbers are the cellShape value that were selected by clicking 194 
on “Cell Labels” on the top right-hand corner. 195 

6. Conclusions 196 
I present an efficient and powerful way to interactively visualize and analyze physics-based 3D vertex models using 197 
ParaView, an open-source software designed for scientific visualization of extremely large datasets. As ParaView 198 
uses the VTK library for its data structures, I first modify a very simple example from the voro++ library, 199 
cell_statistics_vtk.cc, to show how to “convert” a polyhedron’s vertices and faces into VTK data 200 
structures. I provide a general way to loop through a 3D-vertex model’s cells, faces, and points to create the VTK 201 
objects. I modify an example from the voro++ library, random_points_vtk.cc, to implement the pseudocode 202 
and create a timeseries file for time-evolving simulations. To visualize and analyze 3D vertex models, I present 203 
relevant ParaView filters for physics-based models by visualizing scalar and vectorial data. Other relevant tools that 204 
can be useful for debugging, such as the “Hovel Cells On,” are also presented. To generate such examples, codes 205 
are available in vis3Dvertex. 206 

To start using ParaView can be a cumbersome task as the user has to become familiar with the pipeline workflow, 207 
VTK data structures, and polyhedral data structures. However, its existing capabilities of fast visualization, 208 
interactivity, and analysis are very useful to understand 3D vertex-models results in a timely manner. Here, I 209 
present examples to try to bridge the gap for biologists, biophysicists, engineers, and modelers so ParaView can be 210 
used to its potential. In addition, if it comes a day that 3D vertex models need CPU parallelization, ParaView is 211 
ready to be used.  212 
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B- Required Metadata 267 
 268 

Table 1 – Code metadata 269 

Nr Code metadata description  
 

C1 Current Code version V1.0.0 

C2 Permanent link to code / repository used 
of this code version 

https://github.com/pcsanematsu/vis3Dvertex  

C3 Legal Code License GNU General Public License v2.0 

C4 Code Versioning system used git 

C5 Software Code Language used c++ 

C6 Compilation requirements, Operating 
environments & dependencies 

Required libraries: voro++, Eigen3, VTK; examples were 
tested on a Linux machine with the Singularity container 
image available on the release v1.0.0: 
https://github.com/pcsanematsu/vis3Dvertex/releases/tag/
v1.0.0. 

C7 If available Link to developer 
documentation / manual 

https://github.com/pcsanematsu/vis3Dvertex#readme  

C8 Support email for questions pcsanema@syr.edu 
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